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INTRODUCTION 
The term “style” (or “output style”) is used to describe a particular method of documenting your 
work. Each style has format settings for the in-text citation, the bibliography, and citations in 
footnotes. Each style has a template for the in-text citation, the bibliography, and citations in 
footnotes that include what fields should display (and how they are formatted) as well as what 
punctuation should be used.  There are also settings for how authors, journals and page numbers 
are displayed in addition to options for sorting authors, title capitalization, etc. 

While there are many styles included with EndNote (and more you can download from their 
website), it may be necessary to modify a style to make it fit your exact bibliographic needs. 
EndNote allows you to change punctuation, formatting, and even the included fields. However, to 
modify correctly, you have to be aware of the rules that govern styles and the special formatting 
characters used in the style template. 

MODIFYING ENDNOTE STYLES 
To edit a style, go to the Edit menu, choose Output Styles and select Open Style Manager….  

1. In the EndNote Styles dialog box, select the style you wish to edit by clicking on it once. 
If you want to see what the style looks like, click the More Info button, and then click on 
the Style Info/Preview button.  

2. Once you have found and selected the 
style to edit, click the Edit button. Once 
the Style window is open, we suggest you 
Save As… (from the File menu) and 
rename your new style to keep the original 
style intact. 

Some options in the editing dialog box, such as 
Page Numbers and Journal Names, apply globally to 
all four sections (Citations, Bibliography, Footnotes, 
and Figures & Tables). Other options only apply in 
their individual sections –for example, Templates 
appears under each heading (Citations, Bibliography, 
etc.). You must be sure you’re in the correct 
section when making changes. 
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GLOBAL STYLE SETTINGS 
These settings affect citations, bibliographies, citations in footnotes, and figures & tables, so you 
only select an option once. 

Anonymous Works: Choose how you would like 
to display works where the author field is blank. 
Options include Leave Author Blank, Use Full Title, 
Short Title in Place of Author, Use APA Specifications, 
and Insert Text (e.g.: Anonymous). 

Page Numbers: Specify how the page numbers 
should be formatted in references. 

Journal Names: Specify which journal abbreviation 
format to use from your Journals Term Lists. Don’t 
forget to select the Abbreviate Journal Articles Only and 
Remove Periods options, if so desired. When using 
abbreviations, be sure you’ve added them to your 
Journals Term List (see the Journal Abbreviations 
section on page 9). 

TEMPLATES 
Templates control a large part of the style’s look and function. They include field names and 
punctuation commands telling EndNote how to format different references for that particular 
style. Templates show you a sample of what a citation (or bibliography reference) will look like, 
only with field names in place of actual data. When you create a bibliography using the Format 
Bibliography command, EndNote replaces 
the field names with your data. 

You can modify any style – add or delete 
fields, change formatting such as italics or 
bold, or change the punctuation – just by 
making the change in the correct template 
(Citations, Bibliography or Footnotes).  Within 
the specific section, you must also be sure to 
edit the right reference type, such as Journal 
Article or Book. This is particularly important 
for the Bibliography section. 

To add a field, put your cursor where you want the field to appear and select the appropriate 
option from the Insert Field pulldown menu.  Be sure to include any spaces and/or punctuation 
required.   

To delete a field, highlight the field name from the appropriate Reference Type and delete it (again, 
be sure to fix any spacing and/or punctuation).  

Before you start changing templates, however, you should be aware of the rules that govern how 
styles work. 
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RULES THAT GOVERN STYLES 

There are four basic rules of dependence that govern how text, spaces, and field names interact 
with each other when they are used in a style template: 

1. Basic dependence: Any text or punctuation that is not separated from a field name by an 
ordinary space is dependent upon that adjacent field, i.e., text or punctuation adjacent to a 
field only appears in your bibliography if the adjacent field contains data. 
Example: In the excerpt “Volume (Issue)”, the parentheses around “Issue” only appear in 
a formatted reference if there is an issue number for the reference. 

2. The preceding field takes priority over the following field: When punctuation appears 
between two fields with no intervening spaces, it is dependent on the preceding field. 
Example: In the excerpt “Volume:Issue”, the colon is dependent on the volume field. So, 
if there is no volume in the reference, the colon will not appear. 

3. The first space after a field is dependent on that field. Additional spaces are 
independent: The first ordinary space following a field is always dependent on that field. 
Any consecutive spaces after that are independent and will always appear in the formatted 
references. 
Example: In the excerpt “Author. Title”, the space is dependent on the author field so the 
title will not be preceded by a space if there is no author. However, in the excerpt 
“Author.  Title” with two spaces between the author and the title, the title will be 
preceded by one space if there is no author. 

4. Independent text always appears in the bibliography. Any text or punctuation that is 
not dependent on a field name always appears in the formatted references. 
Example: In the excerpt “Edition ed.”, the text “ed.” will appear in all references 
regardless of whether or not there is an edition for that reference. 
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SPECIAL FORMATTING CHARACTERS 

To add flexibility and precision to the grouping of fields and punctuation in the style templates, 
the above rules can be circumvented in specific situations using the following special formatting 
characters: 

Formatting Character Function Example 

Non-breaking space ( ) 

[Ctrl+Alt+Spacebar (PC) or 
Option+Spacebar (Mac)] 

Links adjacent text or 
punctuation to a field. 

In the excerpt “Edition ed.”, 
the text “ed.” will only appear in 
references where there is an 
edition. 

Vertical bar (|) Forces separation of text or 
punctuation that is 
normally dependent on a 
field. 

In the excerpt “Volume|:Issue”, 
the colon is now dependent on 
the issue field. So, if there is no 
issue in the reference, the colon 
will not appear. 

Back apostrophe (`) Identifies text that should 
not be interpreted as a field 
name. 

In the excerpt “Editor, 

`Editor`”, the second “Editor” 
is interpreted as just text and not 
as a field name. 

Caret (ˆ) Separates singular and 
plural versions of terms 
that appear in conjunction 
with Author, Editor, or Pages 
fields. 

In the excerpt “p. ˆpp. Pages”, 
“p.” will precede a single page, 
while “pp.” will precede multiple 
pages. 

 

You can also insert the non-breaking space, vertical bar, caret, tab character ( ), and paragraph 
mark (¶) from the Insert Field pulldown list by choosing Link Adjacent Text, Forced Separation, 
Singular/Plural, Tab and End Of Paragraph, respectively. 

AUTHOR LISTS  
Use this section to specify how the authors and 
editors (with the Editor List) will appear in the 
formatted bibliography or the in-text citations 
(be sure you select Author Lists or Editor Lists 
from the correct section). 

In the Separators area, enter any punctuation and 
spaces that will separate the individual authors. 
Don’t forget to use a different Before last 
separator and define separators depending on 
the Number of Authors, if so desired. 
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In the Abbreviations area of the Author Lists, choose whether you want to abbreviate the list of 
authors after a certain number, using et al. or an equivalent. Make sure to specify the number of 
authors needed to trigger this abbreviation, how many authors to include in the formatted 
reference, what the abbreviation should be, and whether it should be italicized. For in-text 
citations, make sure to specify different abbreviations for the First Appearance and Thereafter, if so 
desired. These options can be found under Author Lists in the Citations section. 

In the For Subsequent Works by the Same Author area, choose how author names will appear after the 
first entry. Author names can be kept, omitted, or replaced for subsequent entries.  

AUTHOR NAME 
In the Name Format area, specify how author 
names should look, i.e., whether the first or last 
name should come first or whether there should 
be a comma after the last name. Make sure to 
specify a different name order for the First 
Author and Other Authors, if so desired. Also 
specify the format for Capitalization and first and 
middle Initials.  

LAYOUT 
Use this section to specify what information, if any, should appear before and after each reference 
in a bibliography. This section also allows you to apply hanging indents to references. 

 A common reference prefix is the bibliography number, which is used by all numbered 
styles to differentiate references in a bibliography. Tabs are often entered after the 
bibliography number to align the start of 
each reference. Other commonly used 
reference prefixes (reference type, label, 
citation, and record number) appear in 
the lower half of the Insert Field 
pulldown list. 

 A common use for the reference 
suffix is to add a blank line between 
references by inserting a paragraph 
mark. Other commonly used reference 
suffixes (label, keywords, abstract, notes 
and record number) appear in the lower 
half of the Insert Field pulldown list. 

 When a hanging indent is used, it indents the second and subsequent lines of each 
reference in a bibliography. It is often used in conjunction with a tab to align the start of 
each reference with subsequent lines when a bibliography number is included. Hanging 
indent options include None and All paragraphs for references with one or more paragraphs 
as well as First paragraph only, Second paragraph only and All paragraphs but the first for 
references with more than one paragraphs. 
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SORT ORDER  
You can determine sort order for bibliographic 
references at the end of your paper and for multiple 
citations in the text. For references in the 
bibliography, the options are as shown on the right. 
Additional options for in-text citations are Same As 
Bibliography, Year + Author, and Don’t Sort. 

TITLE CAPITALIZATION  
You can also specify the capitalization format for 
titles in your bibliographic references. The options are Leave title as entered, Headline style capitalization 
(i.e. the first line of every significant word is capitalized, excluding articles and prepositions), and 
Sentence style capitalization (i.e. only the title’s first letter is capitalized). 

ADDING A CALL NUMBER TO A STYLE 
To add a call number to a bibliographic style, go to the 
Edit menu, select Output Styles, then select Open 
Style Manager…. 

1. In the EndNote Styles dialog box, scroll to the 
style you would like to edit and highlight it by 
clicking on it once. 

2. Click the Edit button. 

3. Remember to go to the File menu and choose 
Save As… to save your edited style as a copy so 
the original style remains intact.  

4. In the dialog box that opens, click on Templates 
under the Bibliography heading (in the left pane). 

5. The reference types for that style will appear 
in the right pane with all of its templates. 
Within the Book reference type, place your 
cursor in the spot where you would like to 
add the Call Number and click Insert Field.   

6. In the list that appears, select Call Number.   

7. Once the Call Number field is added to the 
citation types of your choice, save the style, 
close the dialog box, and close the Style 
Manager.  

8. You’ll need to make sure you format the 
bibliography for your document using this 
new style. 
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USING TERM LISTS 
EndNote term lists are used to store terms (keywords, authors, journal names etc.) within each 
library. Term lists facilitate data entry and improve consistency and accuracy. The update list during 
data entry preference, by default, is enabled. This means that text added to certain fields will be 
automatically added to the term list.  As you begin to enter text into one of these fields, EndNote 
will suggest the closest matching term; continue typing until the correct term appears. Press Enter 
to accept it and create another line or Tab to accept it and move to the next field (continue typing 
if it is not the correct term).  If you enter a new term into one of these fields, the term appears in 
red text to alert you that you have entered a new term. When you close the reference that new 
term is automatically added to the list  

OPENING AND EDITING TERM LISTS 
The following focuses on the Journals Term list but the same principles apply for any of the terms 
lists. To open a terms list, 

1. Go to the Tools menu, choose Open Term List 
then choose the list you’d like to open.  

2. To edit a journal (or any term) in the list, select it 
from the Term List dialog box, be sure you’re in 
the Terms tab and choose Edit Term….  

3. Change the term as necessary and click OK when 
finished.  

You can also manually add a journal (or any term) to the list by clicking on the New Term… in the 
Terms tab of the Term List dialog box. Enter the journal name and its abbreviation(s) and click OK 
to add it to the list and dismiss the New Term dialog box. Clicking Save Journal (or Save Term for 
the other lists) adds the journal to the list, but keeps the window open for you to enter another 
journal. 
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JOURNAL ABBREVIATIONS 
If you add the journal’s abbreviated title in the Alternate Journal field as you enter the reference (or 
as it is imported), the abbreviation will be automatically added to the Abbreviations 1: field of that 
journal in the Journal Term list. 

However, most sources from which you’ll import citations don’t have the journal abbreviations in 
the record. If you need to use journal abbreviations, EndNote comes with 12 journal term lists, 
including those accepted by the National Library of Medicine (NLM), the American Chemical 
Society (ACS), and the Modern Language Association (MLA). Other term lists include 
Anthropology, Law, and BioScience. Depending on your discipline, you may add as many lists as 
you wish. 

1. Go to the Tools menu and choose Define Term Lists. 

2. Click on the Lists tab, choose Journals from the list, and 
then click on Import List… 

3. Browse to the Terms folder in the EndNote application 
folder, then choose the appropriate list and click Open. 
The list will be imported to the selected EndNote 
library. 

Remember, each EndNote library has its own term lists.  

 

To add an abbreviation at a later date, go to the Tools 
menu, choose Open Term List then choose the Journals 
Term List.  

1. Choose the correct journal, be sure you’re in the 
Terms tab and choose Edit Term…. 

2. Add the abbreviation in the Abbreviation 1: field and 
click OK to close the dialog box. 

3. If the style you have selected uses the abbreviation, 
the appropriate abbreviation will appear for all 
articles from this journal, whether or not the 
individuals reference has anything in the alternate 
journal field. 

 

Remember, some styles are not set to use the abbreviation instead of the full journal title, so you 
may need to adjust the style (see the previous section on styles). 

 


	Introduction
	Modifying EndNote Styles
	Global Style Settings
	Templates
	Rules that Govern Styles
	Special Formatting Characters

	Author Lists
	Author Name
	Layout
	Sort Order
	Title Capitalization
	Adding a Call Number to a Style

	Using Term Lists
	Opening and Editing Term Lists
	Journal Abbreviations


